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Reba Nance is the Director of Law Practice Management and Risk Management for the
Colorado Bar Association. She had been with the CBA for 15 years. A frequent
presenter on such topics as law practice management, legal technology, risk management,
and malpractice prevention, Reba has spoken at legal conferences around the U.S. and
Canada. She is very active in the ABA's Law Practice Management section and is a past
Chair of the American Bar Association’s TECHSHOW®, the world’s largest legal
technology conference.

Just prior to her work at the Bar, Ms. Nance served as the Attorney Recruiting
Coordinator for several large Denver law firms. She has also served as a law firm
accounting manager, office administrator, and virtually every other staff position within a
law firm. Reba is a former President of the Denver Chapter of the National Association
for Law Placement.

A former educator, Reba has a B.A. in Liberal Studies with an emphasis in Psychology,
graduating with High Honors from San Diego State University. She also received
Elementary and Special Education teaching credentials from San Diego State. In a
previous life, she taught elementary school and worked with gifted as well as learning
disabled children.
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Tip # 1 - Keeping Track of Requests in a Folder Called @Waiting For

We often use e-mail to request something from someone, or to tell someone that we will do something
for them. By using the tip below, you won't have to worry ever again about forgetting to remind them if
they don't respond. This tip will save an additional copy of your e-mail in a special folder called
@Waiting For. That way, you can check that folder every so often to make sure the person got back to
you. If they haven't, you simply go to @Waiting For, open the e-mail, click on Forward, and send it back
to them as a new e-mail. You can say something like—“l know you're swamped, but I'm checking in to
see if you've had a chance to [whatever you originally asked them to do]?” That way, they get a
reminder which includes the original e-mail (text, date, etc.)! Because the new e-mail already had “wff”
in it, a copy will automatically be put into @Waiting For again and you will have a record of what you
asked for and your follow-up efforts to get it.

1. Create a new folder in your Inbox called @Waiting For (by putting the @ symbol in front, it will
appear at the top of the list of folders

Click on Tools > Rules and Alerts

Click the New Rule button

At the top of the next box, select “Start from a blank rule”

Highlight “Check messages after sending”, then click Next

Check off “With specific words in the body”. Then click on “where specific words is underlined”
and choose a unique keyword for your rule, such as *wff* (for “waiting for folder”) Click Add, then OK,
then Next

DU wN

8. Check off “Move a copy to the specified folder.” Then click on the “where specific Folder is
underlined” and choose the @Waiting For folder
9. Click Finish

The next time you send an e-mail that you might have to follow up on, type wff as the last line of the e-
mail, and this tip will automatically work for you!

Tip #2 — Using Multiple Outlook Windows to Have Inbox and Calendar Open at the Same Time
Have you ever been looking at mail in your Inbox, then wanted to jump to your calendar without
losing your place in the Inbox? Outlook makes it possible through the use of multiple windows. To
open multiple windows, right click on an icon in the Outlook bar (say the Calendar) and pick "Open in
New Window". Now you can see your calendar and your inbox at the same time!

Tip # 3 - Composing and Sending an E-Mail Without Ever Leaving Microsoft Word — Word 2007,
2003 and 2000

Many of us spend much of our time in Word. Wouldn’t it be nice to easily compose and send an e-
mail in Word rather than having to minimize Word, open Outlook to send the message, and then go
back to Word? Here's how to do it in Word 2003 and earlier versions:

For Word 2003 and earlier versions —

1) Open a new Word document and type the text of the e-mail as a normal Word document

2) Click on the E-mail button on Word's standard toolbar (you've probably never noticed it). To find
it, hover your mouse over the icons until you see the word E-mail appear (the button will say Send to
Mail Recipient in Word 2007)

3) Enter the recipient's e-mail address, just as you would if you were typing in Outlook

4) Click on Send a Copy



Word will automatically paste the text of the Word document (where you typed the text of your e-
mail) into the Introduction area of the box on top, send your e-mail via Outlook, and then return you
to the Word document containing the text of your e-mail. You can then exit the Word document
without saving it, and go back to your original Word document.

For Word 2007 — If you use Word 2007, the E-Mail icon is not on the toolbar. You must first add it:
1) Click the Microsoft Office Button (the graphic in the upper left-hand corner), and then click Word
Options

2) Click Customize on the left, and then in the Choose commands from box, click on the down arrow
(the default is Popular Commands)

3) Choose All Commands from the drop-down menu

4) Now scroll down the list until you see Send to Mail Recipient. Highlight it and then click Add (in
the middle of the page) to add the command to the Quick Access Toolbar

5) Click OK

6) The E-mail button should now be on the far right-hand side of Quick Access Toolbar (Look for
Save, Undo, Open, etc. It should be the one on the far right-hand side of that list and say Send to
Mail Recipient. It will now be there any time you open Word (so you won’t have to do this again).

7) Then, repeat steps 1 through 4 above.

Tip #4 - Changing Size of Font While Viewing Pages

If your mouse has a wheel on top for scrolling, you can change the font size on the fly while viewing a
page. Here’s how:

Press and Hold the <Ctrl> button

While holding down the <Ctrl> button, use the mouse wheel to:

- Scroll down (or towards you) to make the font larger

- Scroll up (or away from you) to make the font smaller

Each click of the scroll button changes the font size slightly — so you have almost unlimited control
over the font size

When you decide to change the font size back to the default, go up to the toolbar and:

- Choose View

- Choose Zoom

- Choose 100%

Another way to change the size of the font is to go up to the toolbar and:

- Choose View

- Choose Text Size

- Choose from among the choices of Smallest to Largest

The disadvantage to increasing the size of the font is you will see less text on your screen. But that may
be made up by the fact that you can actually read what’s on the page.

Tip # 5 - Using the “Notes” Feature — Easily Create a Note From Text in Another Program

We all have notes, scraps of paper and lists taped to our monitors walls and keyboards. Use Outlook’s
Notes feature to better keep track of these.

Everyone will find different uses for Notes, but one use is to keep track of lists. Notes is ideally designed
for this because you can:

1) keep track of all these bits of information because they are in a single place;

2) search notes to quickly find what you’re looking for; and

3) print your notes out so you can refer to them.



You might use Notes to create a “to do” list, a list of errands you need to run, a piece of information you
want to remember, or a list of everything you need to buy at the hardware store. I'm sure you’ll find a
ton of other uses.

To create a Note, click on the Notes icon in Outlook. Then click on New. You will get a screen that looks
like a square sticky note. You can type the information just as you would write it on a sticky note.

You also can quickly create a note from text in another program. Simply highlight the text and drag it
onto the Notes button in the Navigation Pane. Notes will automatically open a new note and paste the
text into the note. It couldn’t be easier!

Tip # 6 - Slick Outlook Journal Feature Allows You to Automatically Track Time Spent on Any Activity
Wouldn’t it be nice if you could open just one time entry per day and automatically keep track of the
cumulative time spent on a particular activity for a particular client, regardless of the interruptions?
Journal allows you to keep track of how much time you spend on a particular activity, such as drafting a
motion, attending a meeting, making a phone call, etc. It will keep track of the total elapsed time, while
allowing you to start and stop the timer for interruptions. No math involved! Here’s how:

1) Open Outlook and click on Journal (just as you would In-Box, Tasks, Contacts, etc.)

2) Click on New

3) Enter the following, depending on what you’re doing:

- Subject (Draft Interrogatories or whatever you wish)

- Entry type: there is a drop-down box from which you can choose an item (Document, Phone Call,
Meeting, etc.)

- Company (your client)

- Start time (the date and time are automatically entered for you)

- Click on “Start Timer” button

- Duration: this field will automatically keep a running total of the time spent (minus the time you clicked
“pause timer” for interruptions)

4) Click “Start Timer” when you begin a task. If you are interrupted, click on “Pause Timer,” but leave the
entry open (you can minimize the window). Click “Start Timer” again when you resume your work. You
can open an entry for each activity you're spending time on (including administrative activities, such as
marketing). That way, you can jump back and forth between the entries as you start and stop each
activity. Outlook keeps track of the total elapsed time!

5) All of your Journal entries are listed together (just as e-mails would be), so you can click on the
heading and organize them all by company (client), date, etc. Now you can use this information to enter
your time for the day.

Tip # 7 - How to Get the Full E-mail Address When There’s Only the Name

We often receive e-mails that are sent to groups of people. Sometimes the “To” field will have a
complete e-mail address, and sometimes you will only see the name but no e-mail address. You might
want to respond to a particular individual privately. The problem is all you can see is their name — and
not their e-mail address. If their name is in the header area (To or CC) here’s an easy way to get their
address, too.

Open the e-mail and go to the header area (the header is at the top where you see “To” “CC” and
“Subject”)

Put your cursor over the person’s name.

Right click and Choose “Outlook Properties”

Their complete e-mail address will be shown



Note — this will not work if the person’s name is in the text of the e-mail, or anywhere other than the
header area.

Tip # 8 - Print a Blank Calendar in Outlook Using a Template

We’ve all had an occasion where we need a blank calendar. Here’s how you can set up a template to
print a blank calendar any time you want — and it only takes a few clicks!

Open Outlook.

On the “File” menu, point to “Folder” and then click “New Folder.”

Type a name for the folder, such as Blank Calendar.

In the “Folder contains” list, click “Calendar Items.”

Under “Select where to place the folder,” click “Calendar,” and then click “OK.”

In the Folder List, click on the new folder you just made.

On the “File” menu, click “Print” and then under “Print style” select the type of calendar you want.
Under “Print range” select the start and end dates, and then click OK.

Now you have a blank calendar!

Once you set this up, the next time you want a blank calendar, simply go to the folder where you put
“Blank calendar,” click on it, and print it!

Tip #9 - An Outlook Keyboard Shortcut You Should Use Every Day

You look over the e-mail you've just finished to make sure there are no errors and it's addressed to the
right person. Everything is okay, so you take your hands off the keyboard to grab your mouse to send it.
Stop! There's a quicker way. The mouse is great when you want to choose from among several options.
The next time you are ready to send an e-mail, try holding down the Control key while hitting Enter. Try
this for the next ten e-mails you send. The old adage "use it or lose it" applies here. If you do it several
times in a row, you'll remember the key strokes and you won't have to think about it again.

Tip # 10 - Fight Spam by Getting an E-mail Address That Expires in 10 minutes!

Why would you use this? Maybe you want to sign up for a site that requires that you provide an e-mail
address for validation purposes. Or, maybe you don't want to give up your real e-mail address and end
up on a bunch of spam lists. This is nice and disposable. And it's free. Check it out at
www.10minutemail.com/10MinuteMail/index.html.

Tip # 11 — Print a List of E-mails in Outlook

While most of us know how to print an individual e-mail, what if you want to print a list of e-mails in
your Inbox or in a folder? Chances are if you ever have tried, you ended up with a copy of an individual
e-mail instead of the list you wanted.

Here's how to print a list:
1. Open Outlook and be sure your Inbox is displayed. You should see a list of your e-mails.

2. Select the list of e-mails you wish to print:

- Click on the first e-mail in the list so it is highlighted

- Scroll down (or up) to the last e-mail

- Press the <shift> key and click on the last e-mail

- All of the e-mails should now be highlighted
(If you want to select multiple e-mails that are not in contiguous order, press the <ctrl> key as you click
each e-mail with your mouse to highlight those you want to print.)


http://www.10minutemail.com/10MinuteMail/index.html

3. Go to the toolbar on top and select "File" and then "Print" (just as you would if you wanted to print a
document).

4. The default is typically "Memo Style" (in blue). Change that to "Table Style." Now click on "Only
Selected Rows" and finally click "OK." If you want to see a preview of what it will look like before you
print, click "Preview" before you click "OK" and you'll see exactly what will print!

Tip # 12 - Easily Alphabetize a List in Outlook or Word

Type the list

Highlight the info

Click on format text

In paragraph click on the icon that shows AZ and a down arrow. Have you ever struggled with typing a
list and attempting to put it in alphabetical order at the same time? Or, do you occasionally need to put
an existing list of names in alpha order? What about in date order? Don't waste hours moving the list
around manually - let Microsoft Word do it for you.

Tip # 13 - Color-Code Incoming Outlook Messages by Sender

Coloring incoming messages makes it much easier to see messages from important people, like your
managing partner, best client or significant other! Here's how to color-code incoming messages by
sender:

Highlight any message from the important person

- Choose Tools from the main Outlook menu bar

- Choose Organize from the drop down menu

- Click on Using Colors in the Ways to Organize Inbox dialog box (to the left)

- Choose your desired options in the Ways to Organize Inbox dialog box (Note: We would not
recommend clicking on the Apply Color button on the right - weird things could happen.)

- When finished choosing your options, click on the small x in the upper right-hand corner of the
Ways to Organize Inbox dialog box to close it.

You may need to experiment with different colors to be sure the color is readable in your in box.

Tip # 14 - Adding Contacts Who Belong to the Same Company

If you are creating a number of contacts who work at the same company/firm (or you're adding an
additional contact with the same company) in Microsoft Outlook, save yourself the steps of re-entering
the company's name, address, phone number and fax number each time you create a new contact.
Here's how:

- Open your Contacts folder and select a person who works for the same company/firm as the new
contact you'd like to create.

- Select Actions from the main Outlook menu bar.

- Select New Contact From Same Company from the drop-down menu. When you do, Outlook will open
a new contact form and automatically populate the Company, Address, etc. fields with the information
contained in the existing contact.

- Enter or revise the information specific to the new contact you are adding.

- Click Save and Close and you're finished!

Tip # 15 — Free Outlook Training
Check out http://office.microsoft.com/en-us/support. Click on Outlook and then click on your version of
Outlook listed on the right-hand side of the page.



http://office.microsoft.com/en-us/support

Tip # 16 - Lending Library Has Outlook 2007 for Lawyers in Our Free Lending Library

L _Microsaolt |

OUTLOOK 2007

Tip # 17 - Training on Microsoft Website at www.microsoft.com
Tip # 18 - Lynda.com For Software Training For a Low Monthly Flat Rate

Tip # 19 - Printing a List of E-mails in Outlook
While most of us know how to print an individual e-mail, what if you want to print a list of e-mails in
your Inbox or in a folder? Chances are if you ever have tried, you ended up with a copy of an individual
e-mail instead of the list you wanted.
Here's how to print a list:
1. Open Outlook and be sure your Inbox is displayed. You should see a list of your e-mails.
2. Select the list of e-mails you wish to print:

- Click on the first e-mail in the list so it is highlighted

- Scroll down (or up) to the last e-mail

- Press the <shift> key and click on the last e-mail

- All of the e-mails should now be highlighted
(If you want to select multiple e-mails that are not in contiguous order, press the <ctrl> key as you click
each e-mail with your mouse to highlight those you want to print.)
3. Go to the toolbar on top and select "File" and then "Print" (just as you would if you wanted to print a
document).
4. The default is typically "Memo Style" (in blue). Change that to "Table Style" and click "OK." If you want
to see a preview of what it will look like before you print, click "Preview"

Tip # 20 - Get an E-Mail Address Only for Shopping on the Internet
Tip # 21 - Get an E-Mail Address You Use Only For Clients
Tip # 22 — Outlook - Disabling Forwarding and Reply to All

Outlook 2003 and 2007 both allow you to set up an e-mail form that will prevent recipients from
forwarding your e-mails to anyone else as long as the sender and recipient both use Outlook. This is
done through IRM (Information Rights Management). Although there are ways of getting around this -
the recipient could cut and paste the content of your e-mail into another e-mail and then forward that -
this isn’t as easy as simply hitting "Forward." Plus, the cut-and-pasted e-mail would not have your
"header" information on it, such as your name, your e-mail address, the time and date you sent the
original message, etc.


http://www.amazon.com/Lawyers-Guide-Microsoft-Outlook-2007/dp/1604421436/ref=sr_1_1?ie=UTF8&s=books&qid=1290023197&sr=8-1�

The two links below contain detailed instructions to set this up. Even easier, click on the "Show Me" link
and you will see a step-by-step video, with audio, that walks you through this. Note that the
instructions show you how to prevent "Forwarding" and also prevent "Reply to All." You can setup a
form that does both, or simply create one to prevent "Forwarding" and one to prevent "Reply to All."
The instructions are very straight-forward.

Here’s how to do it in Outlook 2007
http://office.microsoft.com/en-us/outlook-help/prevent-e-mail-message-recipients-from-using-reply-
all-or-forward-HA010131687.aspx?CTT=1

Here’s how to do it in Outlook 2003
http://office.microsoft.com/en-us/outlook-help/prevent-e-mail-message-recipients-from-using-reply-
all-or-forward-HA001114224.aspx?CTT=1

Tip # 23 - Add a New Contact Automatically

Use this handy feature the next time you get an e-mail message from someone who you want to add to
your contacts list. Open the message and place your cursor over the e-mail address in the header of the
message. Right click and choose “Add to Contacts.” Outlook will automatically open a new contact
dialog box and paste the name and e-mail address in the proper fields! Questions? Contact Reba Nance
at reban@cobar.org.

Tip # 24 — Find Word 2003 Commands in Word 2007
Moving from Word 2003 to 2007 can be very frustrating because the interface for Word 2007 is very
different from 2003. This can make it very difficult to find many of the commands in 2007.

Microsoft has developed an Excel workbook that details where to find the old Word 2003 commands in
Word 2007. You can find the workbook here:

http://office.microsoft.com/search/redir.aspx?AssetID=AM101938681033&CTT=5&0rigin=HA10062584
1033

You'll find a worksheet tab for each of the Word 2003 menus and toolbars, and each worksheet contains
a list of the old commands from that menu or toolbar. To the right of these commands you'll find the
way to accomplish the same task in Word 2007.

The workbook can be opened either in Excel 2003 or Excel 2007.

Tip #25 - Free Wireless Internet Connection at the Bar!

Did you know that the Bar Association has free wireless Internet access on the 9th and 3rd floors for
members? If your laptop has a wireless card, you can access our network - affectionately known as
"M@rvin." Check with the receptionists on the 9th or 3rd floors for the password!

Tip # 26 - Metadata Assistant to Scrub Attachments to E-mails
Information on reduced price for CBA members will be sent out in C-Brief. The program is Metadata
Assistant.


mailto:reban@cobar.org

Tip # 27 - Have Your Staff Sign E-mails With Their Title

Gone are the days when law firms list all their attorneys on their letterhead. If you have staff sign
letters, be sure they list their title as well. If they don't, clients, other lawyers and even the court will
assume they are lawyers with your firm. Something simple, such as the sample signature blocks below,
should suffice. And tell them NOT to send personal e-mails using from their work e-mail address.

Very truly yours,

Reba J. Nance
Secretary

(or: Paralegal to John Bigdeal)
(or: Assistant to Susan Farkowitz)

Tip # 28 — Delete and Permanently Delete E-mails

In Outlook, if you highlight an e-mail and press the "delete" key, the e-mail goes from your "in-box" to
your "deleted items" folder - then you still must go to your "deleted items" folder to delete it
permanently. If you know you want to permanently delete an e-mail, highlight the e-mail, press "shift"
and "delete" together. You will get a dialog box asking if you're sure you want to permanently delete the
item. Just say "yes."

Tip # 29 — Maximize or Minimize a Window Using the Title Bar

Whether you're using a mouse or a touchpad, it can be tough to exactly center your cursor over the little
"X" or "-" at the top right-hand side of your screen to change the size of the window. You can
accomplish the same thing by putting your cursor anywhere on the title bar (the one at the top of the
screen.) If the window is maximized and you double-click on the title bar, the window will minimize.
Double-click again to maximize the screen.

Tip # 30 - Get on a CBA List Serve

Tip # 31 - Easily Show the Desktop When You're in Outlook
Go down to the tool bar at the bottom of the page. Place your cursor in a blank spot on the right-hand.
Right click and choose “Show the Desktop”

Tip # 32 — Insert the Current Date or Time by Using Keyboard Shortcuts
1. Place the cursor where you want to insert the date or time.
2. Use the following keyboard combinations:
= Insert today’s date — press Alt + Shift + D
= [Insert the time — press Alt + Shift + T

You can also insert the date and time by going to Insert => Date and Time

Tip # 33 - Keep your calendar sacred - DON’T PUT STUFF ON A CALENDAR IN OUTLOOK UNLESS YOU
PLAN TO DO IT ON THAT DATE!

Tip # 34 - Sending E-Mail on the Fly - Preaddress Them!



If there are people to whom you often send e-mail, you can easily create desktop shortcuts that will
start your e-mail program and automatically address messages to your frequent e-mail recipients.
Here's how:

1) Right-click on the Windows desktop (the screen you get when you first start your computer) and
select "New" from the pop-up menu

2) Select "Shortcut" from the fly-out menu

3) Inthe "Command Line" text box, type mailto: followed by an e-mail address

4) Click "Next" and type a name for the shortcut - such as Bob e-mail

5) Click "Finish" and your new shortcut will appear on your desktop

Go to the Desktop and click on that shortcut and you'll have an e-mail dialogue box open with a pre-
addressed e-mail message.

Tip # 35 - Quick Pic
Tip # 36 - Use the Undo Icon
Tip # 37 - Drag and Drop an E-Mail and Make it an Appointment, Etc.

Tip # 38 - Assign a Task to Another Person and Track It

Many of us use Outlook as our e-mail program. But did you know that it can also keep track of “to do”
lists in the form of “tasks?” You can assign categories and due dates. You can set the “reminder”
function for a certain date and time and you will be reminded to make a phone call or follow up on an
outstanding item. And one of the best features? You can send your staff tasks to do. That way, you
have the task in writing — they don’t forget and you can keep it on your radar screen until it's completed.

Tip # 39 - Figure Out Which Version of Outlook You’re Using

Go to main Outlook page

Click on Help

Click on About Microsoft Office Outlook

Not only will you see the version, but you'll also see the Service Packs that have been downloaded as
well as the Product ID.

Tip # 40 — Select Multiple E-mails on the List to Delete at Once
To select contiguous e-mails —

Open the list

Highlight the first e-mail

Press the Shift key

Highlight the last e-mail

Now you can delete them all at once.

To pick and choose e-mails which are not next to each other in the list -
Open the list

Highlight the first e-mail

Press the Control key

Click on each individual e-mail you want

Now you can delete them all at once.
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Tip # 41 - Use the Open Area in Contacts, Calendar, etc., for Keywords You Can Search On

Tip # 42 - Create a Rule from an Existing Message

The rules feature in Outlook is a great tool to help manage a large volume of e-mail. rules are used to
apply certain actions to frequently received e-mails. Rather than try to create a set of rules up-front,
we've found it easier to create rules on the fly as we receive e-mail.

To create a rule on the fly, right-click on the message in the message list, and choose "Create Rule." In
the "Create Rule" dialog box, Outlook fills in as much information as it can collect from the e-mail,
simplifying the creation of the rule. Once you've defined the conditions of the rule, Outlook will
automatically apply the actions you've specified to every new e-mail received from that contact.

Tip # 43 - Set Up Outlook to Automatically Spell Check All Outgoing E-Mails

Regardless of your spelling or typing abilities, there’s no reason for your e-mails to contain misspelled
words. You can make Outlook 2003 and 2007 automatically spell check all outgoing e-mails before
sending. The following option will force this to occur before you send out a message:

1. Click Tools

2. Select Options

3. Select the Spelling tab

4. Check Always check spelling before sending
5. Click OK

If you also want Outlook to check your grammar at the same time it checks your spelling:

. Click Tools

. Select Options

. Select the Spelling tab

. Check Always check spelling before sending

. Click on Spelling and Auto Correction...

. Under When correcting spelling in Outlook, check Check grammar with spelling
. Click OK

No v b WwWwN R

Tip # 44 - Write a Message Now and Send it Later

Delay the delivery of a single message

1. In the message, on the Options tab, in the More Options group, click Delay Delivery .

2. Click Message Options.

3. Under Delivery options, select the Do not deliver before check box, and then click the delivery date
and time that you want.

After you click Send, the message remains in the Outbox folder until the delivery time.

Tip # 45 - E-Mail Remorse - Ever Hit "Send" And Then Wish You Could Get It Back?

Have you ever sent an e-mail, only to realize two minutes later (or even immediately) that you sent it to
the wrong person, or you forgot to mention something, or you mentioned something you shouldn't
have, or any other of a host of reasons to recall it?

Delay the delivery of all messages

1. On the Tools menu, click Rules and Alerts, and then click New Rule.
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2. In the Step 1: Select a template box, under Start from a Blank Rule, click Check messages after
sending, and then click Next.

3. In the Step 1: Select condition(s) list, select any options that you want, and then click Next.

If you do not select any check boxes, a confirmation dialog box appears. If you click Yes, the rule you are
creating will be applied to all messages that you send.

4. In the Step 1: Select action(s) list, select defer delivery by a number of minutes.

5. In the Step 2: Edit the rule description (click an underlined value) box, click the underlined phrase a
number of and enter the number of minutes for which you want the messages to be held before
sending. Delivery can be delayed up to 120 minutes.

6. Click OK, and then click Next.

7. Select any exceptions that you want.

8. Click Next.

9. In the Step 1: Specify a name for this rule box, type a name for the rule.

10. Select the Turn on this rule check box.

11. Click Finish.

After you click Send, each message remains in the Outbox folder for the amount of time you specified.

Tip # 46 - Launch a Contact's Web Page From Within Outlook

Outlook provides a field on the Contact form for recording the web page addresses of your contacts.
This is especially handy when you need to go to the contact's web site frequently, say to order supplies
from a vendor's web site. To add a web page address to a contact record:

- Click on the "Contacts" icon in the Navigation pane or Folder list

- Double-click on the contact for which you'd like to add a web address

- Click on the "General" tab (if necessary)

- Click on the "Web Page Address" text box and enter the contact's web address
- Click on "Save and Close."

To launch the web page without leaving Outlook, open the Contact and click on the link in the Web Page
Address text box on the Contact form. Your web browser will launch and take you directly to the
contact's website.

Tip # 47 - Make It Easy To Send Someone’s Contact Info to Another Person

Copy their signature block and paste it into the block at the bottom of contacts so you can easily send
their contact info to someone else. See Bill Gibson as an example. Paste in directions to their office, etc.

Tip # 48 - Launch a Map to a Client’s Address Directly From Their Outlook Contact

Tip # 49 — Check out Slipstick.Com — Outlook & Exchange Solutions Center - for Answers to Questions
about Outlook

Tip # 50 — Customize the Look of Outlook by Dragging and Dropping Columns, etc.

12



JOHN R. CHRISTOFFERSON

John Christofferson is an Assistant County Attorney at Arapahoe County. He has been
with the County for two years. John works as legal counsel for the Arapahoe County
Foundation, Inc, Arapahoe County’s 501c3 entity, represents the County and County
employees in state and federal litigation, works with County departments on contracts,
and assists with drafting and revising County and department policies and procedures.
Recently John helped revise Arapahoe County’s drug and alcohol policy, has presented
this policy to the County’s managers and supervisors, and is currently in the process of
presenting this policy to all County employees.

Before joining the County Attorney’s staff, he worked for a Denver law firm specializing
in Title 32 Special Districts for 5 years.

Prior to practicing law, John was a Certified Athletic Trainer working in the Sports
Medicine departments at the University of Tennessee and the University of Colorado,
where he received his masters and bachelors degrees.



COUNTY EMPLOYEE DRUG
AND ALCOHOL POLICIES

!'- AND MEDICAL MARIJUANA

By

John R. Christofferson
Assistant County Attorney, Arapahoe County, Colorado



Public Employee Drug

i Testing

= Legal Considerations — Public vs. Private

= Constitutional Rights — 4" Amendment

= Right to privacy and right to be free of
unreasonable search and seizure.

= Typically, a governmental agency or
department needs to obtain a search warrant
prior to requiring a search or a drug and
alcohol test of a private citizen or
governmental worker.

Colorado County Attorneys Association 2011 Winter Conference



Valid Drug and Alcohol
i Testing Programs

= Suspicionless/Random Testing
= Post Accident Testing

= Reasonable Suspicion Testing
= Pre-Employment Testing

Colorado County Attorneys Association 2011 Winter Conference



Suspicionless/Random

i Testing

Skinner v. Rallway Labor Executives’ Assn., 489
U.S. 602 (1989); and

National Treasury Employees v. Von Raab, 489
U.S. 656 (1989).

= “Special Needs” — requires nexus between
responsibilities of specific positions and the
safety of the public.

= Limit applying random tests to a general
category of employees. (e.g. All law
enforcement employees — not all law
enforcement employees carry guns.)

Colorado County Attorneys Association 2011 Winter Conference



Suspicionless/Random

i Testing (Cont.)

Special Needs Categories:

= Motor Vehicle Operators and
Transportation (Safety Sensitive Positions);

= Police and Firefighters;

» Classified/Sensitive Information;
= Drug Interdiction; and

= Prison Employees.

Colorado County Attorneys Association 2011 Winter Conference



i Post Accident Testing

Skinner v. Raillway Labor Executives’
Assn., 489 U.S. 602 (1989)

= Safety Sensitive Positions
= Critical/Non-Critical Jobs
» Based on individualized suspicion

Colorado County Attorneys Association 2011 Winter Conference



Reasonable Suspicion

i Testing

= Actual Observation or Physical Evidence
of on-duty impairment.

= Any information causing a reasonable
person to believe the employee was
Impaired.

Colorado County Attorneys Association 2011 Winter Conference



i Pre-Employment Testing

National Treasury Employees v. Von
Raab, 489 U.S. 656 (1989)

= Special Needs Categories
= Safety Sensitive Positions

Colorado County Attorneys Association 2011 Winter Conference



Issues Affecting
i Drug and Alcohol Policies

= Federal Drug Free Workplace Act of 1988
= Americans with Disabilities Act of 1990
= Family & Military Leave Act of 1983

= Colorado Anti-Discrimination Act (C.R.S.
8§ 24-34-401 et seq.)

= Colorado Lawful Activities Statute (C.R.S. 8
24-34-402.5)

Colorado County Attorneys Association 2011 Winter Conference 9



i Medical Marijuana

Federal Law
= Controlled Substances Act (21 U.S.C. 88

801 to 971)

= Marijuana Schedule | Drug
= Marinol Schedule 111 Drug

Colorado County Attorneys Association 2011 Winter Conference 10



i State Laws

States Currently with Medical Marijuana Laws
(16 States and Washington DC)

Alaska Maine New Mexico
Arizona Michigan Oregon
California Montana Rhode Island
Colorado Nevada Vermont
Delaware New Jersey Washington

Hawall

Colorado County Attorneys Association 2011 Winter Conference 11



Medical Marijuana In

i Colorado

= 2000 Ballot Amendment 20 passed (54%)
s House Bill 10-1285, effective June 7, 2010
s Senate Bill 10-109, effective June 7, 2010

Colorado County Attorneys Association 2011 Winter Conference 12



i Employment Issues

= Disability

= Accommodation

= Impairment

= Lawful Off Duty Activity

Colorado County Attorneys Association 2011 Winter Conference
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Questions

Colorado County Attorneys Association 2011 Winter Conference
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Thank You

Colorado County Attorneys Association 2011 Winter Conference
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BARBARA J.B. GREEN

Barbara Green is a founding partner of the law firm of Sullivan Green Seavy, LLC where
her practice focuses primarily on land use and environmental law. She was admitted to
the Colorado Bar in 1985, and is admitted to practice law in the State of Colorado, the
10™ Circuit Court of Appeals, and the United States Supreme Court. She holds a B.A.
from Northwestern University, and M.P.A. and J.D. degrees from the University of
Colorado.

Ms. Green represents clients during land use and development processes, from
annexation through entitlement. Additionally, she represents clients during all aspects of
legal challenges to land use regulations and decisions, from trial to appellate proceedings.
Ms. Green has substantial experience working with local governments to improve land
use regulatory processes. Ms. Green also represents clients on environmental matters
relating to hazardous and radioactive waste, Brownfields development, water quality, and
National Environmental Protection Act (NEPA) compliance. Her experience includes
representing clients in rule-making and quasi-judicial permit and enforcement
proceedings.

Ms. Green has served as General Counsel to Northwest Colorado Council of
Governments since 1985 where she advises county and municipal governments on water
issues affecting headwaters of the Colorado Basin, natural resource extraction, land use,
and intergovernmental relations. She currently serves as special counsel to Grand County
on the Moffat Expansion Project and Windy Gap Firming Project NEPA reviews and on
the West Slope negotiation team. Ms. Green also serves as special counsel to Gunnison
County on oil and gas regulation matters and litigation, and she serves as General
Counsel to the Rocky Mountain Low-level Radioactive Waste Compact.

Ms. Green is a member of the Colorado Mined Land Reclamation Board. She also has
served on the Colorado Water Resources and Power Development Authority Board and
the Colorado Groundwater Commission. Ms. Green is a member of the University of
Denver Water Law Review Advisory Board and serves on the Board of Directors of
Colorado Conservation Voters and Colorado Common Cause. She has written and
lectured extensively on land use and environmental issues.
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MARY KEYES

Mary Keyes is a legal assistant with twenty years of staff experience in local government. She is
experienced in supporting local government decision-making, and has an extensive background
working with elected officials, appointed commissions and citizen groups. Her experience
includes research and drafting ordinances, code interpretation, and staff support in the process
of code adoption and for public hearings on land use issues and development proposals.
Ms. Keyes has also worked in the private sector with responsibilities for code review on behalf
of individual property owners and developers.
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June 2005-Present

April 2002-June 2005

August 1999-April 2002

January 1992-August 1999

Selected Presentations:
January 2002

2000 — 2005

1999- 2005

2001

Marilee M. McWilliams
Assistant City Attorney
14980 E. Alameda Ave.
Aurora, CO 80012
(303) 636-1883

Arapahoe County Colorado, Assistant County Attorney
14980 E. Alameda Ave., Aurora, CO 80012
Dependency and Neglect

City and County of Denver, City Attorneys Office
1200 Federal Blvd., Denver, CO 80204
Dependency and Neglect

Indian Child Welfare Specialist

El Paso County, Office of the County Attorney

105 N. Spruce, Colorado Springs, CO 80907

Attorney Assigned to Intake, handled all temporary custody
hearings and initial discover requests

Indian Child Welfare Specialist

Private Practice
105 Hazel Path Mansion, Hendersonville, TN 37075
Bankruptcy and Juvenile

Presenter Indian Child Welfare Conference
Bismark, North Dakota

Indian Child Welfare Act Task Force State of Colorado

In house training at Department of Human Services for
Caseworker regarding Indian Child Welfare Act; Safe
Families Act; Placement and Homelessness; Conflict of
Interest; court procedures; direct and cross examination of
witnesses.

Training for Respondent Counsel, Guardian ad Litem and
Court personnel regarding Indian Child Welfare Act



Outline for Presentation

The act
1901- (1) Congress constitutional authority over Indian affairs.
(commerce clause)

(2) Congress assumed responsibility for protection and preservation of
tribes and their resources

3) biggest resource children

4) High percentage of Indian children being placed in non-Indian
Placements

(5)  That states courts have failed to recognize tribal relations cultural
and social stands of Indian communities.

1902- Policy: to protect the best interest of Indian children, promote stability and
security of tribes and families by establishing minimum federal standards for
removal of children and placement in Indian placements.

1903- Definitions

child custody proceedings: foster care placement; termination of parental
rights; pre-adoptive placements; adoptive placements.

Extended family member: Tribal determination or statutory. Grandparent, aunt,
uncle, brother, sister, brother-in-law, sister-in-law, niece, nephew, first or second
cousin or step parent

Indian member of an Indian Tribe, Alaska Native and a member of a regional
corp.

Indian Child unmarried person under 18 and is either (a) member of an Indian
Tribe or (b) eligible for membership and is the biological child of a member of
the Tribe

Indian Child's Tribe tribe which child is a member or eligible for membership. If
more than one tribe the tribe with the most contact.

Indian Custodian person having legal custody under state law, tribal law, or
custom or to whom temporary physical care, custody, and control has been
transferred by the parent of such child

Indian Tribe recognized as eligible for the services by BIA including any Alaska
Native Village

Parent biological parent or any Indian person who has lawfully adopted an Indian
child including under Tribal law or custom. It does not include the unwed
father where paternity has not been acknowledged or established.



Tribal Court court with jurisdiction over child custody proceedings.

1911- Exclusive jurisdiction: child resides or is domiciled on the reservation.
Where the child is a ward of the tribal court that court will retain jurisdiction.
Concurrent jurisdiction: the court shall transfer the proceedings in absence of
good cause to the contrary. Either parent has an absolute right to veto transfer
and Tribal court can decline to take

Intervention Indian custodian and Indian tribe have right at any time in the
proceedings (foster care placement and termination)

Full faith and credit to any ruling of the Indian tribe child custody proceedings to
the same extent as other states

1912- Notice Involuntary proceedings: party seeking foster care placement of or
termination of parental rights to an Indian child shall notify the parent, Indian
custodian and Indian Tribe by registered mail with return receipt requested of the
proceedings and the right to intervene. If any of the above cannot be located
than notice to the BIA. Cannot occur until at least ten days after receipt of notice
(25 days if BIA) all can ask for an additional twenty days to prepare.
Appointment of counsel If indigency the parent or Indian custodian shall have
right to court appointed counsel in any termination removal or placement
proceedings. Court may appoint counsel for the child if in best interest of the
child.

Examination of reports or other documents all parties have right to examine
documents filed with the court upon which decisions are made involving Indian
children.

Remedial and rehabilitative programs active efforts have been made to
provide remedial services and rehabilitative programs designed to prevent the
breakup of the Indian family and that these efforts have proven unsuccessful.
Foster care placement determination supported by clear and convincing
evidence, including the testimony of a qualified expert witness that the continued
custody of the child by the parent or Indian custodian is likely to result in serious
emotional or physical damage to the child.

Parental rights termination evidence beyond a reasonable doubt including
testimony of a qualified expert witness that the continued custody of the child by
the parent or Indian custodian is likely to result in serious emotional or physical
damage to the child.

1913- voluntary termination

Consent to foster care placement or termination of parental rights must be in
writing and recorded before a judge and accompanied by the judges certificate
that the terms and consequences of the consent were explained and understood
and that it was in a language that was understood by the parent. No consent
signed within 10 days of the birth of the child shall be valid.

Foster care placement withdrawal of the consent at any time the child shall be
returned to the parent or Indian custodian upon the withdrawal.



Voluntary termination the consent maybe withdrawn at any time prior to the
entry of a final decree of termination or adoption, as the case may be and the
child shall be returned to the parents.

Collateral attacks after the entry of adoption the consent can be withdrawn upon
the grounds of fraud or duress and the court may be petitioned to vacate such
decree. Upon such a finding the court shall vacate the adoption and return the
child to the parent or Indian custodian. No adoption may be invalidated after two
years unless otherwise permitted under state law.

1914- Invalidating actions upon showing of violation of the ICWA. If the action
violates the provisions of 1911 1912 and 1913 the action may be petitioned to be
invalidated, Parents, Indian custodians or Tribe has right.

1915- Placement

Adoptive placement preferences In absence of good cause to the contrary (1)
extended family (2) members of the Indian Tribe (3) Indian families

Foster care or pre-adoptive placements least restrictive setting meets his
needs and be in reasonable proximity to his or her home, taking into account
special needs of the child. A preference shall be given in the absence of good
cause to the contrary to (i) extended family (ii) a foster home approved and
licensed by the Indian Tribe (iii) Indian foster home licensed by non-Indian
institution (iv) an institution for children approved by the Indian Tribe or operated
by an Indian organization with a program suitable to meet the child's needs
Tribal resolution can change orders of preferences still subject to being least
restrictive setting appropriate to the particular needs of the child. Where
appropriate the wishes of the Indian child or parent shall be considered.

Social and cultural standards the standards to be applied in meeting the
preferences shall be the social and cultural standards of the Indian community in
which the family or parent resides

Record of placement shall be maintained by the state in which the placement
was made evidencing efforts to comply with the preferences specified and shall
be available for inspection upon request of the secretary or the child's Tribe.

1916- Return of Custody notwithstanding state law whenever an adoption of an
Indian child is vacated or set aside or the adoptive parents rights are terminated
a biological parent or Indian custodian may petition for return of the child and the
court shall return the child unless there is a showing pursuant to 1912 that such
return is not in the best interests of the child.

Removal from foster care change in foster placement such change shall be
under the same requirements as the original foster care placement except where
the child is being returned to the Indian custodian or parent from whose custody
the child was originally removed.

1917- rights of adult adoptees of information on Indian heritage.



1918- right of tribe to assume jurisdiction over child custody proceedings and
procedure for granting of that right by the secretary

1919- state and Indian Tribal agreements.

1920- where petitioner in child custody proceedings has improperly removed the
child from the parent or Indian custodian the court shall decline jurisdiction over
the proceedings and return the child to the parent or Indian custodian unless
immediate danger to the child would result.

1921- If the state standard accords higher protection to the Indian child or parent
that standard shall control.

1922-nothing shall prevent removal or an Indian child who is a resident of the
reservation but temporarily located off the reservation from the parent or Indian
custodian or the placement of the child in foster care in order to prevent imminent
physical damage or harm to the child. The emergency placement shall terminate
when the removal or placement is no longer necessary and child custody
proceedings shall be initiated immediately with appropriate transfers as
applicable.

1923 effective date

1931 grants for programs and welfare codes on or off reservation

1932 grants for off reservation programs

1933 funds for on and off reservation programs

1934 state requirements for notification of the secretary of adoption of Indian
children and information availability. Parents have the right to request

confidentiality of their information.

1952 authorized rules and regulations



ICWA

INDIAN CHILD WELFARE ACT QUICK REFERENCE

IS THIS AN ICWA CASE?: HOW DO I KNOW? HOW DO I FIND OUT?
o Until Court finds that the ICWA applies, the case is NOT ICWA,

o The child’s status determines whether the ICWA applies. The Tribe controls
membership determination, but you are responsible for asking key questions.

Always ask!
1. Is the child a member of an Indian Tribe?

2. Is the child eligible for membership in an Indian Tribe and the biological
child of a member of an Indian Tribe?

If the answer is YES to #1 AND #2 - see other side of this Quick Reference.

If the answer is MAYBE, (or “Yes to 1 OR 2”) Ask some more questions!

3. Ancestry Information.
Ask every relative you can find! (Look for them.)
This will be key information to allow Tribe to determine eligibility.
a. Ask Mom, Dad, Relatives, Kin, anyone who might know.
b. Completely fill out ancestry form.
c. Give ancestry form to Legal, who sends appropriate notices.

4. Continue to inquire. Every time you meet/speak to another relative or
person who might know, continue to ask for ancestry information and
document your efforts. You have a continuing duty to repeat step 3
above.

5. If you’ve done your job and have looked everywhere you should, your
documentation (the evidence) will support the case planning and avert
disaster.

When you know for sure that the child is EITHER a member OR <eligible and child of a
member> then you know that the ICWA applies. See other side of this Quick Reference.

Goal
Keep the child connected to the Tribal family.

If we can’t, we must demonstrate that we have genuinely tried hard to do it.




ICWA APPLIES. 1KNOW THIS FORSURE. NOW WHAT DO I1DO?

1.

Goal: Keep the child connected to the Tribal family.
If we can’t, we must demonstrate that we fried hard to do so.

Within 48 hours: Contract Tribe in person and
a, Notify Tribe of child’s involvement
b. Ask about Tribal placements (relatives, members)
c. Ask who is to receive notices about child/case (get name, address, phone #)

Search for appropriate Indian placement for the child. Ask everyone you meet who knows
anything about this family. Document.

If the Tribe indicates that a relative is available out of state, consider the effect on
reunification of the child being out of state. If it would have no effect on the goal of
reunification and if a Tribal home study approves the home, then place the child. Remember
ICPC does not apply. The Tribal home study is to be accepted.

Keep in contact with the Tribe at least once a month in person and discuss the status of the
child (even if the Tribe chooses not to mtervene in your case). In case of low activity, this
contact should be made after the monthly face-to-face with child. Document this or attempts.

Make active efforts to reunify. Not just a referral. You must assure successful
completion of task. Continuity is required.

If a parent disappears, use all known resources to attempt continuously to locate him/her,
including such things as inmate locator. Document your efforts.

Make appointments for parent to obtain treatment. Offer transportation assistance.
Document your efforts.

Placement preferences:

a. Relative
b. Indian Tribal Member
c. Child’s Tribal-approved Indian foster home or RTC

d. Indian foster home or RTC (not child’s Tribal-approved)

Reminder: Always ask the Tribe for placement resources. If none available, immediately
send a letter to the Tribe, documenting that no appropriate placement exists at this time.
Continue to inquire of the Tribe and document your inquiries.

Important Points to Remember in All ICWA Cases.

iz:gnac;g ;aizﬁf?:;o:h;z;m?g‘n d e  Prove actual and immediate harmn to a child if
and child must be returned to the parent! returned to Indian parent or custodian.

Always be pregared to tf_:stify as an expert at where the presenting problem differs because
placement hearings. Evidence is required to

R of cultural factors.
support the order of placement. Parent’s oral
agreement at new filing can be revoked.

Don’t Take Shortcuts in ICWA Cases Expert Testimony: Placement or Termination

e Culturally sensitive reunification services used




ROBIN COCHRAN
ASSISTANT COUNTY ATTORNEY
ARAPAHOE COUNTY ATTORNEY’S OFFICE

Robin Cochran is an Assistant County Attorney for the Arapahoe County Attorney’s
Office. Robin represents Arapahoe County in employment law and litigation arising in
state and federal courts and provides administrative advice on employment law issues.
Robin recently returned to the Assistant County Attorney position after four years as the
Deputy County Attorney for the Arapahoe County Human Services Legal Division and
held that position from July 2007 to August 2011. In both positions, Robin has been
responsible for responding to requests for Open Records.

Prior to the Deputy County Attorney position, Robin was an Assistant County Attorney
in the Arapahoe County Attorney’s Office from April 1996 to July 2007. Robin received
her Juris Doctorate from Texas Tech University.
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